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Preface

Intended Audience
Welcome to Release 11i of the Oracle Sales Offline User Guide.

This guide assumes you have a working knowledge of the following:

• The principles and customary practices of your business area.

• Oracle Sales Offline

• Oracle Field Sales (formerly known as Oracle Sales Online)

• The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the Oracle
Applications User’s Guide.

How To Use This Guide

This document contains the information you need to understand and use Oracle Sales
Offline.

• Chapter 1 provides an introduction to Oracle Sales Offline.

• Chapter 2 provides information on creating and updating a task.

• Chapter 3 provides information on creating and updating leads.

• Chapter 4 provides information on creating and updating opportunities.

• Chapter 5 provides information on creating and updating quotes.

• Chapter 6 provides information on creating and updating forecasts.

• Chapter 7 provides information on creating and updating customers.

See Related Documents on page viii for more Oracle Applications product information.

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services
within the United States of America 24 hours a day, seven days a week. For TTY support,
call 800.446.2398.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation accessible,
with good usability, to the disabled community. To that end, our documentation
includes features that make information available to users of assistive technology.
This documentation is available in HTML format, and contains markup to facilitate

vii



access by the disabled community. Accessibility standards will continue to evolve over
time, and Oracle is actively engaged with other market-leading technology vendors to
address technical obstacles so that our documentation can be accessible to all of our
customers. For more information, visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/ .

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that consists
solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any
representations regarding the accessibility of these Web sites.

Structure
1 Introduction
2 Managing Tasks
3 Managing Leads
4 Managing Opportunities
5 Managing Quotes
6 Managing Forecasts
7 Managing Customers

Related Documents
Other Information Sources

You can choose from many sources of information, including online
documentation, training, and support services, to increase your knowledge and
understanding of Oracle Sales Offline. If this guide refers you to other Oracle
Applications documentation, use only the Release 11i versions of those guides. Online
Documentation All Oracle Applications documentation is available online (HTML or
PDF). Online help patches are available on MetaLink.

Related Documentation

Oracle Sales Offline shares business and setup information with other Oracle
Applications products. Therefore, you may want to refer to other product documentation
when you set up and use Oracle Sales Offline. You can read the documents online
by choosing Library from the expandable menu on your HTML help window, by
reading from the Oracle Applications Document Library CD included in your
media pack, or by using a Web browser with a URL that your system administrator
provides. If you require printed guides, you can purchase them from the Oracle Store
at http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
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This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI) available with this release of Oracle Sales Offline (and any
other Oracle Applications products). This guide also includes information on setting user
profiles, as well as running and reviewing reports and concurrent processes. You can
access this user’s guide online by choosing "Getting Started with Oracle Applications"
from any Oracle Applications help file.

Documents Related to This Product

Oracle Sales Offline Implementation Guide

This guide provides how to implement and manage Oracle Sales Offline.

Oracle Field Sales User Guide

This guide explains Oracle Field Sales, an HTML-based applications that provides sales
managers, sales representatives, and sales executives with assistance in managing their
business opportunities, customer, forecasting, incentive compensation, partners, and
quotes.

Oracle Quoting User Guide

This guide explains how to use Oracle Quoting to create and manage customer
quotes across all sales and interaction channels. Oracle Quoting is used to propose
product solutions and perform negotiations, while enforcing consistent business rules
throughout the sales cycle. Users can publish and print quotes, and eventually convert
quotes to orders.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle Applications
products. In Release 11i, much of the installation process is handled using Oracle Rapid
Install, which minimizes the time to install Oracle Applications, the Oracle8 technology
stack, and the Oracle8i Server technology stack by automating many of the required
steps. This guide contains instructions for using Oracle Rapid Install and lists the tasks
you need to perform to finish your installation. You should use this guide in conjunction
with individual product user’s guides and implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. You
cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade, Auto
Patch, AD Administration, AD Controller, AD Relink, License Manager, and others. It
contains how-to steps, screenshots, and other information that you need to run the AD
utilities. This guide also provides information on maintaining the Oracle applications
file system and database.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
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This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products

This guide contains the user interface (UI) standards followed by the Oracle Applications
development staff. It describes the UI for the Oracle Applications products and how
to apply this UI to the design of an application built by using Oracle Forms. Oracle
Applications Flexfields Guide This guide provides flexfields planning, setup and
reference information for the Oracle Sales Offline implementation team, as well as for
users responsible for the ongoing maintenance of Oracle Applications product data. This
manual also provides information on creating custom reports on flexfields data.

Training and Support

Training

Oracle offers training courses to help you and your staff master Oracle Sales Offline and
reach full productivity quickly. You have a choice of educational environments. You
can attend courses offered by Oracle University at any one of our many Education
Centers, you can arrange for our trainers to teach at your facility, or you can use
Oracle Learning Network (OLN), Oracle University’s online education utility. In
addition, Oracle training professionals can tailor standard courses or develop custom
courses to meet your needs. For example, you may want to use your organization’s
structure, terminology, and data as examples in a customized training session delivered
at your own facility.

Support

From on-site support to central support, our team of experienced professionals provides
the help and information you need to keep Oracle Sales Offline working for you. This
team includes your Technical Representative, Account Manager, and Oracle’s large staff
of consultants and support specialists with expertise in your business area, managing an
Oracle8i server, and your hardware and software environment.

OracleMetaLink

OracleMetaLink is your self-service support connection with web, telephone menu, and
e-mail alternatives. Oracle supplies these technologies for your convenience, available
24 hours a day, 7 days a week. With OracleMetaLink, you can obtain information and
advice from technical libraries and forums, download patches, download the latest
documentation, look at bug details, and create or update TARs. To use MetaLink, register
at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or upgrade
any of your Oracle Applications. Navigate to the Alerts page as follows: Technical
Libraries/ERP Applications/Applications Installation and Upgrade/Alerts
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Self-Service Toolkit: You may also find information by navigating to the Self-Service
Toolkit page as follows: Technical Libraries/ERP Applications/Applications Installation
and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser,
database triggers, or any other tool to modify Oracle Applications data unless otherwise
instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus
to modify Oracle Applications data, you risk destroying the integrity of your data and
you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an
Oracle Applications form can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a row
in one table without making corresponding changes in related tables. If your tables get
out of synchronization with each other, you risk retrieving erroneous information and
you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps track of
who changes information. If you enter information into database tables using database
tools, you may store invalid information. You also lose the ability to track who has
changed your information because SQL*Plus and other database tools do not keep a
record of changes.
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1
Introduction

This chapter covers the following topics:

• Overview

• Oracle Sales Offline Key Features

• Oracle Sales Offline Integrations

• Accessing Oracle Sales Offline

• Territory Driven Download

• Sales Team Driven Download

• Forecast Driven Download

• Navigating in Oracle Sales Offline

• Setting Synchronization Preferences

• Synchronizing Data

• Conflict Resolution

• Non-Validated Records (Rejected Records)

• Timing Log

• Version Identification in Oracle Sales Offline

• Status Bar Messages

Overview
Oracle Sales Offline gives you the information you need to remotely manage your sales
efforts, and offers sales organizations the functionality required in an interface that is
both familiar and effective. Leveraging the capabilities of desktop applications, Oracle
has designed a template that provides sales organizations a way to manage sales
information without the need to install additional software.

The template is downloaded from Oracle Field Sales or Oracle Sales and provides
upload/download data capabilities. Oracle Sales Offline provides you with the ability
to view and edit sales information, while your support organization does not have to
support any additional technical software on laptops.

To manage and close deals successfully, sales teams often cross group
boundaries, territories and even company lines. Oracle Sales Offline works with
Oracle Field Sales or Oracle Sales and with Oracle Telesales to create a virtual sales
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team that enables the sharing of opportunities, contacts, notes, and other customer
information between sales team members. You can automatically or manually assign
opportunities to sales members. Sales representatives can see information from partners
about their accounts as they prepare for on site meetings. Oracle’s sales automation
modules complement each other and provide the solution for team selling in a dynamic
environment.

Oracle Sales Offline imports and exports (synchronizes) information from an
Oracle enterprise database, and enables you to view and update your sales
information remotely via your laptop computer. You can add, view and edit
customers, opportunities, leads, quotes, and forecasts from your laptop, saving the
changes for subsequent upload.

You can optimize your selling time in the field by having key customer information
readily available. This enhances your relationships with customers and promotes
company profitability. Oracle Sales Offline integrates with the Oracle Sales
applications, and is designed to maximize sales effectiveness in the mobile
environment. Oracle Sales Offline is part of the Oracle E-Business Suite, an integrated
set of applications that are engineered to work together.

Oracle Sales Ofine Key Features
Oracle Sales Offline includes the following features:

• Lead Management

• Opportunity Management

• Customer Management

• Sales Forecasting

• Offline Quoting

• Task Management

• Flexfield Support

• Home Tab - New Items and Conflict Resolution

• Incremental Synchronization

• Synchronization Preferences Filters

• Upload MyChanges Synchronization

• Multilanguage Support (MLS)

• Common Product Catalog

Lead Management

You can manage leads and qualify them into sales opportunities in Oracle Sales
Offline. Leads can be prioritized so that you can target activities on hot leads
first. Oracle Sales Offline gives you access to lead information such as notes history, and
key contacts. All changes to the lead can be synchronized back to the enterprise
database. Also, you can perform the lead to opportunity business flow in Oracle Sales
Offline.

Opportunity Management
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You can manage opportunities remotely through the sales cycle. Oracle Sales Offline
gives you access to opportunity activities and statuses, notes history, key contacts and
sales credits. You can create and update the opportunity information by adding new
notes, and changing the opportunity status. Access to this information and the ability to
update it enables sales organizations to sell more effectively. Sales team members can
share information about call activity, major issues, and account strategy. All changes to
the opportunity can be synchronized back to the enterprise database. Also, you can
perform the opportunity to quote business flow in Oracle Sales Offline.

Customer Management

Oracle Sales Offline gives sales representatives the information they need to manage
their sales efforts when they are on the road. Mobile sales agents have access to detailed
customer information, product interests and notes about their customers. Contact
information lets representatives identify key players within their accounts and share that
information with other members of the sales team.

Sales Forecasting

Oracle Sales Offline enables you to build forecasts constructed from opportunities. You
can update Sales forecasts on the road, and synchronize forecast commitments back to
the enterprise database so sales managers can view them.

When you use Oracle Sales Offline in conjunction with Oracle Sales, forecasting
functionality is not available.

Offline Quoting

Oracle Sales Offline supports mobile quoting functionality. The quoting functionality
enables you to maintain and develop customer quotes. You can view detailed quote
information, such as customer account information, contact details, and ship-to and
bill-to information. You can add, remove, and price products using offline quoting. You
can performmanual price adjustments at the product line level. You can also synchronize
all changes to the quote back to the enterprise database.

Task Management

Oracle Sales Offline supports task management features. You can download tasks that
are assigned to you, or that you own. You can view and edit these tasks in Oracle Sales
Offline, and you can create new tasks. Tasks can be stand-alone, or associated to an
Oracle business object. You can use the Calendar form to display tasks for a particular
day or date range in Oracle Sales Offline.

Flexfield Support

Oracle Sales Offline supports customer defined flexfields, where applicable. You can
download flexfields established in the online sales applications to use in Oracle Sales
Offline. You can add, view, and edit data captured in these flexfields, and have the data
synchronized to and from the online sales applications.

Home Tab - New Items and Conflict Resolution

The Home Tab of Oracle Sales Offline, the first window you see in the application, lists
newly added or changed records during the last synchronization. Initially, the Home tab
will not list any records. New or changed items are listed as the result of subsequent
synchronizations. Records are listed in the various tables, depending on the source of
the record. Non-validated records are also listed in the Home Tab.

The Conflict Resolution subtab is available in the Home Tab. The conflict resolution
sheet displays conflicted records that occurred during synchronization, and provides a
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side-by-side comparison of the local client record and the associated server record. You
can reapply or discard the conflict records directly through Oracle Sales Offline.

Synchronization Preferences Filters

The Synchronization Preferences allows you to selectively download sales data
and filter data based on Oracle business objects such as, organizations, leads and
opportunities. These download options can be saved and edited.

Incremental Synchronization

Oracle Sales Offline supports incremental synchronization for uploading and
downloading sales data. After the initial installation, only the records that have been
changed or added in Oracle Sales Offline are uploaded during synchronization, and only
the records that have been added or changed in the online applications are downloaded.

Upload MyChanges Synchronization

Oracle Sales Offline supports the Upload MyChanges synchronization for uploading
sales data. If this option is selected, only the records that have been changed or added
in Oracle Sales Offline are uploaded during synchronization. Upload exceptions for
an Upload MyChanges synchronization are flexfield information, profiles, and quote
addresses. Records that have been added or changed in the online applications will
not be downloaded.

Multilanguage Support (MLS)

Oracle Sales Offline is MLS compliant. Multilanguage Support includes:

• Language Data Handling: Support for characters from any language as data in
the application.

• Locale Formatting: Support for local formats for date, time, number, address, and
name.

• Search and Sort: Support for locale-specific searching and sorting.

Common Product Catalog

Oracle Sales Offline supports the common product catalog, which is used by all Sales
applications. In the past, product categories were limited to interest type, primary
codes, and secondary codes. Using the common product catalog, multiple levels of
product categories are possible based on implementation needs. Product catalog security
is inherited from the security set in Oracle Field Sales/Oracle Sales.

The common product catalog is part of Oracle Product Lifecycle Management
and manages product hierarchy. Your product catalog is set up in Oracle Product
Lifecycle Management. A hierarchical catalog called Product is seeded for use by
Sales and Marketing. You can either use this seeded catalog or create a new product
hierarchical catalog with Product Categories. See the Oracle Product Lifecycle Management
Administrators Guide for details.

Oracle Sales Ofine Integrations
Oracle Sales Offline works with either Oracle Sales or Oracle Field Sales, but some
features may not be available. Oracle Sales Offline integrates with:

• Oracle Field Sales: Oracle Field Sales is an application designed for field sales
representatives, sales managers, and executives. This application provides a
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complete set of tools that enables sales teams to manage the sales cycle from
beginning to end.

• Oracle Quoting: Oracle Quoting is used to propose product solutions and perform
negotiations, while enforcing consistent business rules throughout the sales
cycle. Users can maintain quotes, and eventually convert quotes to orders. This
integration applies only if offline quoting is used in Oracle Sales Offline.

• Oracle Sales: Oracle Sales is an application for sales professionals that simplifies
and optimizes the task of planning and managing the sales process. Oracle
Sales simplifies the sales process by providing complete visibility into the sales
cycle, helping companies to plan and manage effective selling activities.

Accessing Oracle Sales Ofine
Oracle Sales Offline is available from the online Sales application, in the form of a
compressed file.

Reference

Oracle Sales Offline Implementation Guide

Login

Log in to Oracle Applications to access Field Sales or Oracle Sales.

Responsibility

Oracle Field Sales: Sales Online User

Oracle Sales: Sales User

Navigation

Oracle Field Sales: Mobile Tab > Template Download > Download Oracle Sales Offline
Template

Oracle Sales: Preferences Link > Sales Offline Template Download

Steps

If you are a first-time-user, download Oracle Sales Offline by clicking on the Download
Sales Offline Template link from the Mobile tab in Oracle Field Sales. If you are using
Oracle Sales Offline in conjunction with Oracle Sales for the first time, download Oracle
Sales Offline from the Preferences link of Oracle Sales before proceeding.

Navigate to the downloaded file SalesOffline.zip in your directory. Unzip the file into
your folder and run Oracle Sales Offline by double-clicking on SalesOffline.xls. Enable
macros when prompted.

If Oracle Sales Offline fails to open when you choose to enable the macros, verify the
macros security is set to the medium or low level. You can do this by navigating to Tools
> Macro > Security in Microsoft Excel 2000.

Click the Sync icon. Enter the requested user information and then click Sync. The
synchronization preferences will display the first time you Sync. Enter the download
criteria by choosing the Territory Driven Download, Sales Team Driven Download, or
Forecast Driven Download. If you are using Oracle Sales Offline in conjunction with
Oracle Sales, the Territory Driven Download and the Forecast Driven Download are
not available.
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You can filter your data using the Sync preference filters associated with the
downloads. See Setting Synchronization Preferences for details. You can save these
preferences to use in future synchronizations.

Not all synchronization preferences filters are applicable to the Forecast Driven
Download.

The following sync preference filters are applicable to Territory Driven and Sales Team
Driven downloads:

• Lead Preferences - Filter by Status, Channel, Lead Rank, Budget Status, Time
Frame, or Number of Records

• Opportunity Preferences - Filter by Status, Sales Stage, Sales Channel, or Win
Probability (From/To)

• Quote Preferences -Filter by Inventory Category Set (inventory item or
product), Inventory Category, or Price List

You must select items (from the Default Category Set, the Sales and Marketing
Category Set, or the Price List) for download. You can select items from multiple
categories. You can select multiple lines from one category set by highlighting a
row and using the Ctrl or Shift functions.

• Forecast Preferences - Filter by Period Type, Category, Start Period and End
Period, or Credit Type (only available in the Oracle Sales Offline - Oracle Field Sales
compatible version)

• Customer Preferences - Filter by Customer Category, or Country

Territory Driven Download
The Territory Driven download adds features to the functionality provided by the Sales
Team Driven download by limiting the downloaded address and contact data to that
pertaining to your sales territory. This enables you to download a smaller quantity of
data more relevant to your day to day sales activities. Use Territory Manager to establish
Sales territories. Manual Territory Location assignment can also be performed in Oracle
Field Sales.

The Territory Driven Download accounts for only the address-specific qualifiers, such as
postal code. It does not take into account territory qualifiers, such as named accounts. If
you use the Oracle Territory Manager assignment process, establish the territory address
qualifiers before using this synchronization option. You can also manually assign a sales
user to a certain Oracle business object. Manual assignments will also be synchronized
by Oracle Sales Offline using the Territory Driven Download.

When an Organization or Person is downloaded via a Territory Driven Download, its
address will be downloaded only if it is located in a user’s Sales Territory.

The Territory Driven downloads affect Oracle business objects available in Oracle Sales
Offline in the following manner:

Organization and Persons: The Territory Driven Download downloads only Customers
with an address that resides within a sales representative’s established sales territory
via an established address qualifier. The Territory Driven Download will download
only Contacts related to an Organization, with an address that resides within a sales
representative’s established sales territory.
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Opportunity: If a Oracle Sales Offline user is on the sales team (automatically assigned
via territory or manually assigned) for an Opportunity, the Opportunity is synchronized
to Oracle Sales Offline.

Note: Only Opportunity contacts which reside in the Oracle Sales
Offline user’s territory are downloaded with the Opportunity. Contacts,
associated to the Opportunity, that do not have addresses associated
with the Oracle Sales Offline users territory will not be downloaded
for viewing in Oracle Sales Offline.

Lead: If a Oracle Sales Offline user is on the sales team (automatically assigned via
territory or manually assigned) for a Lead, the Lead is synchronized to Oracle Sales
Offline.

Note: Only Lead contacts residing in the Oracle Sales Offline users
established territory are downloaded with the Lead. Contacts, associated
to the Lead, that do not have addresses associated with the Oracle Sales
Offline users territory will not be downloaded for viewing in Oracle
Sales Offline.

Quotes and Tasks: The Territory Driven Download does not affect the Task or Quote
synchronization method. If you are on the sales team of a Quote (regardless of Territory
information), the Quote is synchronized to Oracle Sales Offline. If you own or are
assigned a Task, the Task is synchronized to Oracle Sales Offline.

Note: The Territory Driven Download is not available in Oracle Sales
Offline when being used in conjunction with Oracle Sales.

Sales Team Driven Download
The Sales TeamDriven downloadwill result in records based on your sales team access. If
you are on the sales team of an Oracle business object (for example, organization, lead, or
opportunity) these records are downloaded to Oracle Sales Offline.

Forecast Driven Download
The Forecast Driven download of data is based on the opportunities that are open within
the forecast range selected. Customer organizations and contacts that are associated
with the opportunities are downloaded.

Note: The Forecast Driven Download is not available in Oracle Sales
Offline when being used in conjunction with Oracle Sales.

Navigating in Oracle Sales Ofine
In Oracle Sales Offline, tabs indicate the first layer of information and subtabs show
further details. Links enable you to access detailed information about specific items.

The Table 1-1 describes navigation features and fields:
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Table 1-1 Navigation in Oracle Sales Ofine

Navigation Feature Description

Tab Enables you to navigate among the areas of
functionality in the application.

Subtab Enables you to access additional functionality
under a tab.

Link or hyperlink Enables you to navigate to additional levels of
detail under the subtab.

Asterisks Designate required fields. These fields have
a white background. Fields with a white
background and no asterisk are optional. Fields
with a grey background are read-only.

Column headings Enables you to sort rows of information.
Clicking on a column heading will sort rows
in ascending or descending order based on the
information in the selected column.

Go button Enables searches for a list of values.

Ctrl F Enables you to search for a specific value.

Setting Synchronization Preferences
Oracle Sales Offline enables you to select preferences for synchronization. These
preferences apply to the data downloaded from Oracle Field Sales. During the initial
synchronization, Oracle Sales Offline, will, by default, perform a full download of
necessary data. Using preferences to select subsets of data to download can contribute
to improved application performance. You can modify these preferences after making
your initial choices.

Steps

1. In Oracle Sales Offline, click the Profile icon.

2. Make your synchronization selection.

3. Click Save to save changes or Sync to start the synchronization process (which will
save changes on completion).

Synchronizing Data
The Oracle Sales Offline synchronization process uploads changes or additions to
the server and downloads changed or added records back to Oracle Sales Offline on
your laptop. You do not have to log into Oracle Field Sales/Oracles Sales to upload
and download data. The synchronization function handles this process within Oracle
Sales Offline. See Setting Synchronization Preferences for details on changing data
synchronization preferences for your data downloads.

To ensure the synchronization function works correctly clean out (delete old files)
your Web ADI folder located in the Windows temp folder (C:\Documents and
Settings\<username>\Local Settings\Temp\WebADI)

Steps
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To synchronize data:

1. In Oracle Sales Offline, click the Sync icon.

2. The Sync Login window appears. Enter your user name and password.

Upload MyChanges- Selecting this checkbox allows you to upload only data added
or modified in Oracle Sales Offline. After downloading a new Oracle Sales Offline
template, Oracle recommends that you perform a full synchronization as an Upload
MyChanges synchronization cannot be performed.

The Upload MyChanges synchronization differs from the incremental or full
synchronization processes in that there are no downloads of additions or changes
to server data. The Upload MyChanges synchronization is only available if you
have modified or created records, and is disabled if no changes have been made or
another synchronization is in process.

3. Click OK. The Sync Console appears. A status bar shows the progress of the
synchronization. While the synchronization is in progress, you can:

Go Offline- Click to go offline while synchronization is in progress.

Note: To disable the saving of your Sync Preferences, navigate to
Oracle > Go Offline Autosave, and disable the autosave.

Go Offline enables you to use Oracle Sales Offline in a read-only (locked) mode. Any
changes that you make while Oracle Sales Offline is in locked mode are not
saved. Data synchronization must complete before you can create, modify, or
save data in Oracle Sales Offline. Go Offline is not available during some parts
of the synchronization. For example, you cannot choose Go Offline when the
synchronization engine is downloading data.

If you click the Sync button, or attempt to save data while the synchronization is
offline in locked mode, you will receive this message:

Sync and Save disabled while in Locked Mode:

The buttons on the tabs (for example, Task or Lead) are not disabled (greyed out)
while Oracle Sales Offline is in locked mode. However the functionality associated
with these buttons is disabled.

While in locked mode, if you close the worksheet, and then reopen it, you will
receive this message:

Do you want to complete the unfinished sync?

You can do one of the following:

Yes - continues the synchronization. You will have to provide a login password. The
Sync Console will appear and display the synchronization status bar.

No- enables you to remain in the offline (Locked mode.

Cancel Sync:

Click to cancel the synchronization that is in progress. This button is functional
at the beginning of the synchronization. As the synchronization progresses, you
eventually will not be able to cancel, and this button is disabled. The Cancel button
is disabled when the synchronization process is writing to the enterprise database, to
protect the integrity of the database.
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Show or Hide Details:

Click Show to expand the Sync Console and show synchronization processing
messages. These messages are similar to a log file. Click Hide to hide the processing
messages.

4. You will receive a message at the end of the synchronization process informing you
that either the synchronization was successful or it failed to complete.

If you receive conflict errors, navigate to the Home tab and click the Conflict
Resolution subtab to resolve the conflicts in the Conflict Resolution screens (see
"Conflict Resolution").

If you receive a server not found and not available error, contact your administrator
for assistance.

5. At the successful end of the synchronization, messages indicating the
synchronization is complete and reminding you to you save your data display. Click
Yes to save or No to cancel the save.

Oracle strongly recommends that you save your date after the synchronization
completes.

Conict Resolution
Using a remote application that synchronizes information with an enterprise database
can result in data conflicts. Conflict resolution is critical to using a remote application
successfully, and it is important that up-to-date and accurate information is written to
the enterprise database.

Note that the server record will always override your Oracle Sales Offline client record. If
the same server and client record has been changed in between synchronization
processes, a conflict will occur, and the server record will override your client record. You
can resolve the conflict in the Home tab, using the Conflict Resolution subtab.

During a full and incremental synchronization, all conflicts associated with a particular
user are downloaded. To minimize the data downloaded during an Upload MyChanges
synchronization, only conflicts created during a particular Upload MyChanges
synchronization are retrieved. While you can reapply or discard conflicts after
performing an Upload MyChanges synchronization, you cannot view the online record
associated with that conflict. Error messages indicate the cause of the conflict.

Note: If you are using Oracle Sales Offline in conjunction with Oracle
Sales, conflict resolution functionality is only available through Oracle
Sales Offline. Oracle Sales does not display any conflict resolution
pages, and will not allow users to resolve conflicts while using the online
Oracle Sales application.

Steps

To resolve conflicts between the Oracle Field Sales/Oracle Sales database and Oracle
Sales Offline:

1. Open Oracle Sales Offline.

2. Click the Conflict Resolution subtab in the Home tab.

3. In the Conflict Resolution screen, you will see tables listing the conflicts that occurred
during synchronization.
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4. Click the link to see details of the conflicted record and make the necessary
updates, if needed, before deciding to apply the changes or discard them.

The left side of the form contains your local Oracle Sales Offline record while the
right side of the form contains the Oracle Field Sales/ Oracle Sales server record. The
fields that caused the conflict are shown in red.

If you choose Reapply, the Oracle Sales Offline record will override the Oracle Field
Sales/Oracle Sales record. You must perform a synchronization for your record to be
applied to the database. If you choose Discard, your Oracle Sales Offline changes
will not be applied to the Oracle Field Sales/Oracle Sales server. If you discard the
conflicts you do not need to perform a synchronization.

5. From the main Conflict Resolution screen you can select groups of conflicted records
to Reapply or Discard. Select the checkbox by the record(s) you want to reapply or
discard. If you want to reapply your changes to the server, click Reapply. If you
want to discard the conflict, click Discard.

Non-Validated Records (Rejected Records)
You can view rejected records in Oracle Sales Offline, as well as a message indicating
why the record was rejected. Any record that is created in Oracle Sales Offline that
does not pass the online validation rules during the upload-synchronization process is
captured in a Non-Validated record table in the Home tab of Oracle Sales Offline. The
non-validated records table displays each record that did not pass the server validation
rules and the reason why the record did not get applied to the server. You can also rectify
(Reapply, Discard or Cancel) the non-validated record while in this table.

The table contains two columns, Non-Validated Records and Sync Time. The
Non-Validated Records column contains the record name with hyperlink. The Sync Time
column contains the server date stamp for the non-validated record’s synchronization.

The most recent non-validated records are listed at the bottom of the table. If a
non-validated record is a header record, then any accompanying line records are
grouped together in the table, with the header record listed above the line records.

If the rejected records are related (for example, an opportunity header item and the
related opportunity lines), these records are grouped together in the non-validated
table. If a header record results in a conflict, it is the first item in the grouped
records, followed by the related line items.

Both rejected header and lines records are listed. Click the identifying text for the
rejected record and activate the hyperlink that will generate the conflict resolution
details form. You can read the resulting error message, determine the details of the
conflict record, and then choose what action to take (either Reapply or Discard) for
the non-validated conflict record.

Failed Quote Header and Line Records
Quote records with conflicts are grouped in the list of Non-Validated Records on the
Home page of Oracle Sales Offline. Quote headers that fail validation are hyperlinked to
the Conflict Resolution form, with no associated quote lines listed. Quote headers that
pass validation, but have associated quote lines that fail will be listed with those failed
lines hyperlinked to the Conflict Resolution form.

Note: Quote header flexfields are not supported in this release.
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If the quote header contains the conflict, the quote will not be included in the list of
Quote Names shown on the Quote tab until the conflict is resolved. Quotes with conflicts
in the quote lines will be listed in the Quote Names list on the Quote tab.

Note: Oracle Field Sales and Oracle Sales users cannot transform a
quote into an order when one or more lines in the quote are in a conflict
state. The exception to this is the conflict status Stale Records.

The Oracle Sales Offline Error status appears in the Status field on the General tab of
the Quote Details window. This occurs when a quote has a conflict in the quote lines
that must be resolved in Oracle Sales Offline. Until the conflict in the quote lines is
resolved, the quote is in a read-only status and only Tasks can be updated. All buttons
are disabled at this point, with the exception of Cancel.

Note: There is no status transition during the quote approval
process. Quotes with statuses such as contract required, approval
pending, contract pending, and order submitted will retain the current
status. However, you may still have Oracle Sales Offline errors, so verify
the status of the quote.

In Oracle Field Sales, you can update the Tasks and Notes for this quote, but it will
otherwise be in the read-only state until the conflict in the quote lines is resolved.

If you choose to Reapply a header record:

This message will appear:

• Are you sure you wish to reapply this record? If you choose to reapply this
non-validated record, youmust perform a synchronization operation for the record
to be applied to the online server applications. This record, and all its associated
line items, if applicable, will be applied to the online server applications.

Click OK or CANCEL. If you choose Cancel, there is no further action.

If you clicked OK, the header record is removed from the non-validated table, a
row is inserted into the summary sheet for the quote, and the record is queued for
synchronization.

If the header record has related line records, the associated records will also be removed
from the non-validated table.

If you choose to Reapply a line record:

This message will appear:

• In order to reapply this record you must also reapply the header record. Please
select, and reapply the header record from the Non-Validated records table.

Click OK.

The line record will remain in the non-validated table and will only be removed when
the header record is reapplied or discarded.

If you choose to Discard a header record:

This message will appear:

• Are you sure you wish to discard this record? If you choose to discard this
non-validated record, this record and all its associated line items, if applicable, will
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be removed from Oracle Sales Offline. This record will NOT be synchronized to
the online server applications, and will be removed from Oracle Sales Offline.

Click OK or CANCEL.

If you clicked OK, the header record is removed from the non-validated table, no row is
inserted into any summary sheet and the record is removed from Oracle Sales Offline.

If the header record contains related records, then the line records will also be removed
from the non-validated table as well as the related data.

If you choose to Discard a line record:

This message will appear:

• In order to discard this line level record you must first discard the header
record. Please select, and discard the header record from the Non-Validated
Records table. If you choose to do so, both the header record and all its associated
line records is removed from Sales Offline.

Click OK.

Note: For quotes, users have the ability to discard a conflicted line
without first having to discard the header record. For example if a
quote is created with twenty line items and one of the line items fails
validation, in the Non-Validated Records section, a link to the failed
line item will be provided. You may choose to update the line item and
re-apply or discard the line item completely.

Failed Lead to Opportunity Flow Records
A Lead for which the user performed the Lead to Opportunity flow in Oracle Sales
Offline and/or online sales applications between syncs, will be displayed in the Conflict
Resolution table of Oracle Sales Offline. This only occurs if the same lead record has
been changed in both the online sales applications and Oracle Sales Offline. The server
changes will override the client changes for the lead.

The Lead header information will be captured in the Lead table of the conflict resolution
sheet. The lead will become read-only because of its Converted To Opportunity
status, and only the Discard and Cancel buttons will be activated.

If any Lead child (for example, Sales Team, Lead Purchase Line) information is changed
in Oracle Sales Offline, these child records will appear in the appropriate table of the
conflict resolution sheet. None of these child changes will be uploaded to the online sales
applications. In the appropriate conflict form (i.e. Lead Purchase Line, Sales Team), only
the Discard and Cancel buttons will be activated.

When the Lead in conflict has been converted into an Opportunity, the following
message displays:

Lead (LEAD NAME) has been converted into an opportunity in the online sales
application. This lead is now read-only. Please discard this lead conflict, and make
any appropriate changes to the leads corresponding Opportunity.

Timing Log
The timing log provides timing statistics for these events:

• Opening a file
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• Synchronizing data

• Saving a file

These statistics enable administrators to analyze Oracle Sales Offline’s performance and
identify issues that may arise when a large volume of records are processed.

Enabling Detailed Logging

Steps

By default, the timing log is always enabled. You can choose to enable detailed logging.

1. Open SalesOffline.xls.

2. Select Oracle > Logging > Detailed.

3. You can also choose Reset to restart the logging, so that the existing log file is deleted
and a new one begun during your current session.

4. Exit the template.

5. Reopen the template.

The next time you synchronize your data, Oracle Sales Offline will write detailed
logging information about events to the log file. The log file, aslclient.log, is located
in the logs directory in the folder containing Oracle Sales Offline.

Note: Each time you open the Oracle Sales Offline template, the log file
is copied to a .bak file, and the .log file is cleared. To view the timing
log, you must look at the log in the logs directory before you open the
template.

Logging for a Full or Incremental Synchronization

Steps

The first synchronization of the Oracle Sales Offline data is a full synchronization.
Subsequent synchronizations are incremental.

1. Open SalesOffline.xls.

2. Perform a full synchronization by selecting the Sync button and providing login
information.

3. Exit the template.

4. View the resulting log file in the logs directory in your Oracle Sales Offline folder.

Version Identication in Oracle Sales Ofine
You can provide support personnel with a unique version number that identifies the
implemented client version of Oracle Sales Offline by navigating to Oracle > About
Sales Offline. This enables you to identify the version of the client in use when you
report an Oracle Sales Offline problem.

Status Bar Messages
Status bar messages for phases that relate to the processes of file open, file close, file
save, and synchronization in Oracle Sales Offline are displayed in the Microsoft Excel
status bar.
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2
Managing Tasks

This chapter covers the following topics:

• Overview of Managing Tasks

• Entering Transactions and Details

Overview of Managing Tasks
Use the Task tab to view, create, and edit tasks. Tasks are your day-to-day activities
related to customers, leads, and other sales-cycle events. Also, the Calendar button
enables you to access a Daily Task summary, which lists your tasks occurring between
specified start and end dates.

The Task tab displays all of your tasks, or tasks that have been assigned to you.

Note: Oracle Sales Offline does not support recurring tasks.

The task number is generated after synchronization.

Click Calendar to access a Daily Task Summary. This summary displays all of the tasks
that have a start date of a specified day, or within a date range.

If you are using Oracle Sales Offline in conjunction with Oracle Sales, the following
conditions apply:

• The Task date type, which appears on the Oracle Sales Offline Task Detail and Create
forms, corresponds to the date type setup in the profile, Task Manager : JTF Tasks
default date selected. The date type rows that do not correspond to the date type in
this profile above will be dynamically disabled in the Task Detail and Create forms.

• Only related contacts of the header-source Organization in Oracle Sales will be
downloaded from Oracle Sales to Oracle Sales Offline. Any contact added to the
Task in Oracle Sales which does not have a contact relationship to the header-source
Organization of the Task in Oracle Sales, will not be downloaded to Oracle Sales
Offline.

Entering Transactions and Details
References Tab

The References tab in Oracle Sales Offline will not automatically populate reference
rows. On synchronization, the newly created task and the reference rows will
automatically be created in the online sales application, and the appropriate reference
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rows are synchronized to the Oracle Sales Offline task. You have the option of adding
additional rows in Oracle Sales Offline.

For example, if you select a contact, Brenda Johnson@ Business World, the references
for the contact Brenda Johnson and organization Business World are automatically
generated by the online applications after you synchronize.

Assignments Tab

The Assignments tab in Oracle Sales Offline will not automatically populate any
assignment rows. With the next synchronization, the assignment’s owner row for the
new task is automatically created in the online sales application, and the owner row
is synchronized to the Oracle Sales Offline task record. The owner of the task is the
Oracle Sales Offline user who created the task. You may add additional assignee rows
in Oracle Sales Offline.
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3
Managing Leads

This chapter covers the following topics:

• Overview of Managing Leads

• Creating an Opportunity from a Lead

Overview of Managing Leads
Use the Lead tab to view and manage leads. Leads capture the initial contact with
potential customers, gathering information to inform the sales organization regarding
customer interest. When a lead is entered, it can be ranked and assigned to the
appropriate sales resource.

Once enough information has been gathered, a lead can be qualified by a sales
representative.

Leads can be generated through various sources:

• Marketing campaigns and trade shows can generate leads that you can import into
the system through the Lead Import process.

• TeleSales agents record lead information from phone calls.

• Field sales representatives record lead information from the field into a sales
application.

Note: There is Flexfield support for Header and Purchase Item level
flexfields for leads. If Flexfield functionality has been implemented
for a lead, the Flexfield name, field, and Flexfield button are
displayed.

When you use Oracle Sales Offline in conjunction with Oracle Sales, any Lead or
Opportunity created with a Person party in Oracle Sales Offlline will have limited
viewing, creating, and editing capabilities after being synchronized with Oracle Sales.

Creating an Opportunity from a Lead
In the Lead Details window, click Lead to Opportunity.

This information will flow from the lead to the new opportunity into a new Opportunity
Detail window:

• Lead Name (Opportunity name)
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• Customer Name

• Primary Contact

• Project

• Budget

• Currency

• Source (header level)

• Offer (header level)

• Address

• Lead Purchase Items (including quantity, amount, source, and offer)

• Sales Team

• Contact

In Oracle Sales Offline you can convert any lead to an opportunity, regardless of
status, In Oracle Sales you can only convert leads in open status. When the Lead to
Opportunity flow is initiated (when Oracle Sales Offline is being used in conjunction
with Oracle Sales), the lead status will change to Converted To Opportunity and become
read-only. If the lead does not have a sales methodology specified in Oracle Sales, then
the newly converted opportunity will not have the sales methodology or corresponding
sales stage specified.

In Oracle Sales Offline, the converted opportunity will display the sales methodology
and sales stage based on the profile settings OS: Sales Methodology and OS: Default
Opportunity Sales Stage. Oracle Sales Offline does not support a sales methodology
for Leads.
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4
Managing Opportunities

This chapter covers the following topics:

• Overview of Managing Opportunities

• Creating a Quote from an Opportunity

Overview of Managing Opportunities
An opportunity is a potential sale. This process begins with the initial customer contact
and ends when the sales representative makes or loses the sale.

Sales representatives can manage existing opportunities, assigned to them manually or
automatically through Territory Assignment, or they can enter new opportunities.

By default, the sales representative who created the opportunity has full access to the
opportunity. Full access to the opportunity means that the sales representative who
created the opportunity can add other sales team members, assign sales credits, and rate
the likelihood that the opportunity will succeed.

Note: There is Flexfield support for Header and Purchase Item levels
for opportunities. If Flexfield functionality has been implemented for an
opportunity, the Flexfield name, field, and Flexfield button display.

When you use Oracle Sales Offline in conjunction with Oracle Sales, the following
conditions apply:

• Oracle Sales Offline will not support the rolling forecast flag for opportunity
lines. The Opportunity header date will not trickle down to the forecast date on any
purchase item line. Forecast dates will only appear on the purchase lines when a
user explicitly enters a date on the line.

• All sales credit information for an Opportunity must be added or edited using
Oracle Sales.

Creating a Quote from an Opportunity
In the Opportunity Details window, click Create Quote to flow the opportunity
information into a new quote. A new quote can be created based on information that
flows from an existing opportunity. Only purchase item rows with a specified inventory
item numbers (along with it’s associated quantity) are carried over to the new quote.

This information will flow from the opportunity to the new quote into a new Create
Quote window:
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• Opportunity Name (flows to the Quote Name field)

• Customer Name

• Contact Name

• Sales Channel

• Opportunity Purchase Items (if they have specific inventory items on the purchase
item line)

• Sales Team

• Address
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5
Managing Quotes

This chapter covers the following topics:

• Overview of Managing Quotes

Overview of Managing Quotes
A quote is the communication of pricing and discounts for a particular sale. When the
customer is ready to order a particular product they are notified of this available pricing
and discount information through a quote.

In order to add items to a Quote, you must select specific items from the Profile Sync
Preferences Quote tab. Only those items downloaded to Oracle Sales Offline can be
used to add new products to the quote.

Quote Header Tab

• Apply Button: After a new Quote is created, click Apply to display additional
tabs. The Tasks and Notes tabs will not display until you click Save then re-open
the window.

• Place Order Button: The Place Order button will highlight on the Oracle Sales
Offline, Quote Details window if the Place Order status transition is established
in the Quoting application. If payment terms are not specified, the Place Order
button is disabled.

Lines Tab

• Service Item: If you want to add a service item (for example, Warranty) to an existing
product line, highlight the specific line by clicking the radio button associated with
the product line, click Add Services, and search or select a service item to attach to
the product line. You will only be able to add service item lines for product lines
that are serviceable items.

Approvals Tab

Approvals: If you have approvals established for the Quoting application, the Initiate
Approvals button will appear in the Approvals tab of the Quote Details window. Click
Initiate Approvals to initiate the approvals process. The Quote must be synchronized for
the approvals engine to begin the approval process. No approval rows are displayed in
the Approvals tab of the Quote Details window.
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6
Managing Forecasts

This chapter covers the following topics:

• Overview of Managing Forecasts

• Opportunity Worksheet

• Product Category Worksheet

• Generating Forecasts

• Viewing and Submitting Forecasts

Overview of Managing Forecasts
Forecasting is a quantitative tool used to predict the amount of sales for a specified time
period. Managers and sales team members can use forecasting to commit to the amount
of sales that they will close by the end of the forecasting period.

Use these worksheets to create forecasts:

• Opportunity Worksheet: Opportunity-level forecasting provides a tool for sales
representatives to use to create their own view of, and commitment to, sales
opportunities for themselves and others on the sales team. Opportunity forecasting
also gives sales representatives the ability to review, modify, and commit at a more
detailed product category level.

• Product Category Worksheet: Forecasting at the Product Category level
provides sales representatives access to their pipeline aggregated into product
groupings. They can then forecast their sales at the product level by rolling up
opportunity lines into product groupings.

When you use Oracle Sales Offline in conjunction with Oracle Sales, Oracle Sales
Offline does not support any forecasting functionality. The Forecast Tab is not available
for mobile users in Oracle Sales Offline, and the Oracle Sales Offline forecast module
opportunity worksheets, product category worksheets and generate forecast features
are not available in the Oracle Sales compatible version. You cannot submit forecast
values at the Opportunity line level for any Opportunity in Oracle Sales Offline. The
Opportunity header forecast value and Sales Credit information are not available in
Oracle Sales Offline.
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Opportunity Worksheet
Opportunity Level Forecasting provides a tool for sales team members to view their
forecasted opportunities. Worksheets are submitted with the generated forecasts chosen
for submission. To view opportunity worksheets:

• Use Previously Saved Values: If you are forecasting for the first time, the value is
based on the Oracle Field Sales profile preferences. If you have saved an opportunity
worksheet, those values will default.

• Use Pipeline Default Values: This includes all deals available for forecasting whose
close date falls within the current forecasting period. If you choose this option, the
pipeline amounts for the period are populated into the worksheet.

Edit the forecast values by highlighting the cells (Worst Case, Forecast, Best Case)
and adding the value. The forecast numbers will reflect the opportunity forecast data
available in Oracle Sales Offline.

Product Category Worksheet
Forecasting at Product Category level enables sales team members to view their pipeline
aggregated into product groupings. Worksheets are submitted with the generated
forecasts chosen for submission.

Generating Forecasts
The Forecast tab contains the Generate Forecast subtab. Sales representatives can
generate individual forecasts for multiple periods from this window. Forecasts are
generated based on their current downloaded pipeline values. You can forecast based
on the default currency.

Viewing and Submitting Forecasts
The forecast will be submitted when you synchronize. Only the most recent submission
is accepted. You can submit only one forecast per synchronization.
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7
Managing Customers

This chapter covers the following topics:

• Overview of Managing Customers

Overview of Managing Customers
The Customer tab contains three subtabs: Organization, Contact, and Person. By
default, the Customer tab opens to the Organization window. Click the Contact subtab to
open the Contact window, or the Persons subtab to open the Persons window. A person
may be a contact for an organization. An Organization may have one or more contacts.

Note: There is Flexfield support for customers. If Flexfield functionality
has been implemented for an organization or contact, the Flexfield
name, field, and Flexfield button will display.

You can edit information for an existing Organization, Contact or Person by clicking
on the Organization Name, Relationship link or Person Name. To specify a new
Organization, Contact or Person click Create.

Selecting an Existing Organization or Person Record

When creating a Lead or Opportunity, choose an existing Organization or Person record
by selecting the Organization or Person radio button. Click Go to list the organization
name or the person’s name and address in the search results.

Enter a customer name or search for a customer. Enter the customer name in the
customer field, or enter part of a customer name and click Go. Select a customer from
the list of customers that displays or search for another customer.

Select an address by clicking Add or Change next to the address field. A list of customer
addresses displays in the Select an Address window. Click the radio button next to the
address and click Select.

Creating a new record

When creating a Lead or Opportunity, create a new Organization or Person by selecting
the Organization or Person radio button. Click Create Customer to create a customer.

Note: Quotes may only be created for existing Organizations.

When you use Oracle Sales Offline in conjunction with Oracle Sales, a mobile user must
create the Person record first and then add Contact relationship information in order
to create the Contact relationship record. After a successful sync, online users may
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access these newly created Contacts by drilling into the contacts information from Oracle
Sales. None of the Person information added or edited within Oracle Sales Offline
will be exposed in Oracle Sales. Only these Persons related to an active Organization
(i.e. Contacts) will be accessible in Oracle Sales.
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